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There’s something about Word
Suzanne Durkacs, Academic and Distributed Computing Services

T he University Technology Training Center (UTTC) is offering three
Microsoft Word 2000 short courses during the spring 2004 semester.
For $100 or less, you can take any one of the three courses and be on
your way to a more productive workday!

For a complete list of courses — includ-
ing topics, fees, dates, and times
— see At-a-glance,Word 2000 Short
Courses for Spring 2004 on page 4.

During these fiscally lean times when each
department is rethinking where every dollar is
spent — or even worse — having to do more
work with less help, it just makes sense to
learn how to use a powerful computer
application like Word as efficiently as possible.

Word 2000 topical courses
We developed the curriculum for the hands-
on Word courses to be topical in structure,
abandoning the level I and level II break-
down offered in the past. Staff and faculty can
make the most of their time and money by
choosing the course that best matches their
needs without second guessing what types of
tasks would be covered in a Word level I or
level II class.

Top 10
Rejected Word 2000
Short Course Titles

110. All you need is Word.
09. Word lifts us up where we

belong.
08. Word is a many splendid thing.
07. Word is not a dirty word!
06. I’m mad as heck, and I’m not

going to take Word as it is
anymore!

05. Word: I honestly love you.
04. Word: would any other name

smell as sweet?
03. Word: are you talking to me?
02. I’m OK. You’re OK. Word’s OK.
01. Stupid Word tricks.

OIT
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The length of time for each class varies depending
upon the topic, an improvement over the nine-hour
class time of the level I and level II courses. Commit-
ting nine hours out of a busy work week was an
obstacle preventing some staff from taking the courses.
Reducing the class time, along with the tuition, makes
the revised Word courses more appealing to staff and
faculty with small budgets and busy schedules.

Coming up with descriptive and succinct titles of the
three new Word 2000 short courses proved to be more
difficult than developing the courses themselves. (See
Top Ten Rejected Word 2000 Short Course Titles on page
1.)

■ Editing and Sharing
Documents Made Easier
This course focuses on learning the skills needed to
edit and revise documents among users in a work
group.

Often times there is a need not only to revise a docu-
ment, but also to show the author exactly what edits
have been made. That’s where Word’s Track Changes
feature comes in. Track Changes is an invaluable tool
for displaying deletions and insertions made in a
document while revising it. I must admit that having
Word keep track of every change I make while I am
revising a document is very distracting. I prefer to
make the most of the Track Changes tool by using
Compare Documents... instead.

One of the more popular lessons I teach in this course
is the one about comparing two documents. The
hardest thing to remember about using Compare
Documents... is the easiest thing to forget: making a
copy of your original document. Before you attempt to
compare two documents, be sure to have a naming
convention that works for you. I prefer to give each its
own version number, i.e. DocumentV_1,
DocumentV_2, and so on. For some users, copy works
just as well, i.e. Document, Document_copy.

■ Hints, Tips, Shortcuts,
and Secrets
A new course offered this spring is Word 2000: Hints,
Tips, Shortcuts, and Secrets. This course evolved out of
many discussions with class participants and users who
call 1-HELP seeking guidance with taming Word.

Tip 1: Editing & sharing
How to compare two documents
M Make a copy of the document you want to

revise and compare. Using Save As... works
well. This leaves the original document intact.
This will become your new document.

M Revise and edit the new document. Make sure
you save your changes.

M To begin comparing your two documents, be
sure to start by opening the new document.

M Choose Tools menu » Track Changes »
Compare Documents... navigate to the
original (older) document » click Open.
Insertions and deletions in the newer docu-
ment are compared with the original document
and displayed. Changes are tracked.

M To accept or reject changes, choose Tools
menu » Accept or Reject Changes » Find.

M Go through each tracked change to either
accept or reject it.

A lot of timesaving material will be covered in this two
and one-half hour class. Suzanne Garfield and I are co-
teaching this new course. Garfield has been using
Word for so many years that she refuses to confess
exactly how many years she has been a Word user. Her
expertise is welcome.

Modifying Word’s initial settings can make a big
difference in your “enjoyment” of using Word. Make
the adjustments in Tip 2 to prevent auto-numbering,
disable click-and-type, and spell check all words.

■ Formatting Papers Efficiently
Susan McKinnnell developed and teaches the Word
2000: Formatting Papers Efficiently course. Using
styles to help format everything from chapter titles to
bibliographies is covered in this three-and-one-half-
hour course. Learning how to insert and format
footnotes, endnotes, and figure references is also
included, along with cross-referencing those citations.
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Tip 2: improving
Word’s initial setup
M PC users go to Tools » Options;

M Mac OS 9.x users go to Edit » Preferences…

M Mac OS X users go to Word » Preferences… ».

Edit
Deselect When selecting automatically select
entire word.

Don’t enable Click and Type, since it can cause
problems with tables.

Spelling and Grammar
Deselect Check grammar as you type since it
consumes a lot of memory.

Deselect Ignore words in upper case.

View (preview of Office 2003 tips)
Deselect Live Word Count. This feature eats up
laptop batteries. If you need a word count, you
can always select Tools » Word Count.

Tip 3: Format adjustments
Go to Format » AutoFormat… » Options…
button » AutoCorrect appears.

Select AutoFormat
Apply: deselect Headings, Lists, Automatic
bulleted lists, Other Paragraphs.

Replace: deselect Internet paths with
hyperlinks.

Select AutoFormat As You Type
Apply as you type: deselect Headings, Borders,
Tables, Automatic bulleted lists, Automatic
numbered lists.

Automatically as you type: deselect Format
beginning of list item like the one before it,
define styles based on your formatting.

Select AutoCorrect
Deselect Capitalize first letter of sentences,
Correct two initial capitals.

If you Replace text as you type, be sure to
deselect Automatically use suggestions from
the spelling checker.

Suzanne Garfield says:
“In my opinion the single most useful tool in
Word is Styles. Assigning and defining styles gives
you the ability to change formatting throughout a
document in one ‘swell foop.’ It makes formatting
so much easier.”

Students, teaching assistants, and faculty writing thesis
and/or professional papers will benefit from taking this
course.

■ Suzanne Durkacs, Academic and Distributed
Computing Services

Dossier: Susan McKinnell, Word Instructor

✓ Title ➻ Information Technology Professional in the
Academic and Distributed Computing Services Department;
host of TechTalk

✓ First paying job ➻ Busser, Mufaletta in the Park, 1986

✓ Education ➻ University of Minnesota, 1993

✓ People would be surprised to know that ➻ I majored in
Art History

✓ Marital status and children ➻ married since 1995;
2 children, Arthur and Lewis

✓ Number of years you have been using Word ➻ 15

✓ Number of words you type per minute ➻ hmm, I just got
76 wpm on an online test

✓ Movie you could see over and over ➻ Persuasion, 1995

✓ What three things can be found in your refrigerator? ➻
I guess you want me to name interesting things...
cornichons (you know, those little French pickles), flax
seed, and my hand!

✓ Secret vice ➻ what, you want me to share? Chocolate,
but it’s not that secret

✓ Dream vacation ➻ Florence and the surrounding Tuscan hills

✓ U’s best kept secret ➻ free Symantec anti-virus software

About the Microsoft Campus Agreement...
■ The Board of Regents approved a three-year agreement, com-
mencing July 1, 2003, between the University of Minnesota and
Microsoft Corp. to provide a suite of Microsoft’s most popular
software for use on computers that are owned by the University.
For more information about this campus agreement see:
http://www.umn.edu/ucs/Microsoft/CampusAgreement.php.
■ Training: in the near future University Technology Training Cen-
ter will update its curriculum to include the latest version of Word.
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● Editing and Sharing
Documents Made Easier
This 6-hour course is designed for
those working on projects that
involve revising and tracking
changes between users and/or
those that work with long docu-
ments.

Topics include:
• working with templates
• using styles
• using section breaks
• formatting long documents
• tracking revisions
• using comments
• creating tables of contents

Fees*
Students .......................... $65.00
Staff and faculty ...........  $100.00
Alumni and others ......... $190.00

Date, time, location
• Tue. 3/09, 9:00 AM–noon
• Thu. 3/11, 9:00 AM–noon
• both in Eddy Hall Annex 54

Instructor
Suzanne Durkacs

● Formatting Papers
Efficiently
This 3.5-hour course will give
participants timesaving skills to
effectively format thesis or profes-
sional papers.

Topics include:
• working with basic paragraph

and document formatting
• using styles for formatting

consistency and ease of
updating

• using headers and footers
• using section breaks for

chapters, title pages, and
bibliographies

• using footnotes and endnotes
• creating a table of contents
• using captions and cross-

referencing

Fees
Students .......................... $45.00
Staff and faculty .............  $60.00
Alumni and others ......... $125.00

Date, time, location
• Thu. 4/08, 1:00 PM–4:30 PM
• Anderson Hall 170

Instructor
Susan McKinnell

At-a-glance
Word 2000 Short Courses for Spring 2004

■ All courses are taught on the Windows platform using Microsoft Word 2000.
■ Prerequisites: good working knowledge of the Windows operating system.

(Macintosh users: if there is sufficient interest, we will add Word training for Macs.)
■ Register online or get more information at: http://www.umn.edu/uttc

● Hints, Tips, Short-
cuts, and Secrets
This 2.5-hour course outlines
timesaving hints, tips, tricks, and
secrets of using Word. Those who
are new to Word, as well as those
who are experienced with it, will
benefit from taking this course.

Topics include:
• revising Word’s default

settings to meet individual
needs

• customizing menus and
toolbars

• getting the most out of
features such as format
painter, find and replace,
bullets and numbering, and
automated fields

Fees*
Students .......................... $40.00
Staff and faculty .............  $50.00
Alumni and others ........... $90.00

Date, time, location
• Wed. 4/14, 9:30 AM–noon
• Eddy Hall Annex 54

Instructors
Suzanne Garfield
Suzanne Durkacs

Microsoft Word 2000

* The fee for this course includes the cost of a workbook, which will be distributed in class.
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This month I want to share with you
some of the successes that we’ve
enjoyed through the use of the
Usability Lab that we have in Walter
Library. This lab is a cooperative
venture between OIT, the Digital

Technology Center, and academic researchers from
Rhetoric, Computer Science and Engineering,
Kinesiology, and Journalism and Mass Communica-
tion. The lab has been around for just over a year,
and the use has grown tremendously.

The lab is used for three main purposes:
• to ensure the usability of the

software created by OIT
• to provide a lab for academic

use for class projects, research,
and marketing efforts

• to promote usability as an
outreach activity for academic
departments, other universi-
ties, and business partners of
the University of Minnesota

We’ve been successful in all areas.
Over the past year, the Usability
Lab has been in use over 16 hours
per week on average. This growth
is even faster than we had hoped it
would be, and it shows how useful
many people believe the usability
process is.

Various functions — such as
usability evaluations on software,
card-sorting activities and accessibility reviews — have
been performed for a multitude of clients. These
clients include the Controller’s Office, Enrolled
Student Services/Office of the Registrar, Human
Resources, Office of Student Finance, Sponsored
Projects Administration, Information Management
Systems, University Relations, College of Continuing

Education, Health Careers Center, Digital Technology
Center, University Foundation, School of Public
Health, broad-based enterprise projects such as
HIPAA training and Central Authentication logon,
and the list goes on!

We hope that the lab will continue to grow and
provide the University of Minnesota a great service as
we all try to improve the services that we offer to the
whole University. I expect that it will, given its success
thus far!

A huge thank you to all of the folks at the University
who helped to make this service such a success!

■ Scott Ruud, Deputy CIO,
Enterprise Application Systems,
http://www.umn.edu/oit/enterprisemanagement/

The Good News

Usability Lab

More pictures of the evaluator and observer rooms here: http://web.umn.edu/Webteam/usability/usabilityLab.html

Alice de la Cova
Usability Services Manager

http://web.umn.edu/Webteam/usability/
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March: DMC Spotlight Issues
Each month, Digital Media Center (DMC) consultants publish information on our web site
about a current educational technology issue discussed at sessions of the Technology-En-
hanced Learning (TEL) Seminar Series, in our classes, or at our program or project meetings.

Learning technologies and
public engagement

T he Morrill Act of 1862 (also known as the
Land-Grant Bill) permanently endowed the
University of Minnesota for the purpose of

promoting “the liberal and practical education” of
Minnesota’s citizens. This panel will explore how
technology might best be used to support the
University’s land-grant mission by improving access to
learning, enhancing community participation, promot-
ing civic engagement, and supporting efforts to
improve the well-being of our communities and
citizens.

Seminar: March 4th
Please join in a discussion of this topic:

March 4, 2004
12:00-1:30 P.M., 274 McNeal Hall
Moderator: Victor Bloomfield

Victor Bloomfield from the Department of Biochemis-
try, Molecular Biology, and Biophysics, Twin Cities
campus will moderate a discussion among the follow-
ing panelists:

• Katherine Fennelly, Hubert H. Humphrey
Institute of Public Affairs, Twin Cities campus;

• Laurel Hirt, Career and Community Learning
Center, Twin Cities campus;

• Susan Tade, Digital Media Center, Twin Cities
campus; and

• Twin Cities community members affected by the
panelists’ TEL projects.

Campus projects
The panelists have developed or are in the process of
developing technology-enhanced learning materials
and activities that support public engagement; some
are being developed as part of TEL and other grants
projects:

• Fennelly, Katherine. “Using Technology to Train
Students and Health Professionals on Immigrant
Health Issues” [2000–01 Technology-Enhanced
Learning Grant proposal]. University of Minne-
sota, 2002. http://dmc.umn.edu/grants/2000
/KatherineFennelly.pdf.

• Hirt, Laurel. “Enhancing Community Involve-
ment through Communications and Information
Technology” [2003 Council on Public Engage-
ment grant proposal]. University of Minnesota,
10 December 2003.

• Tade, Susan, producer. “Tech Talk” [TV show].
University of Minnesota, 2003–04. More informa-
tion: http://techtalk.umn.edu.

Bibliography and other resources
An overview of the topic, information about the
panelists’ TEL projects, a bibliography, and informa-
tion about related campus resources will be available
on the DMC web site a week before the seminar. A
summary of the seminar, a complete bibliography, and
profiles of the panelists’ projects will be available on
that page shortly thereafter. See: http://dmc.umn.edu
/spotlight/public-engagement.shtml

Student views of TEL

S tudents increasingly come to the college
classroom with a well-defined set of expecta-
tions and prejudices related to instructional

technologies. To date, published surveys have afforded

The Morrill Act of 1862 (also known as
the Land-Grant Bill) permanently endowed

the University of Minnesota for the purpose
of promoting “the liberal and practical
education” of Minnesota’s citizens.
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us insights into students’ views of the efficacy of
particular technologies for supporting learning,
experiences with specific hardware and software
packages, and beliefs in the motivational power of
instructional technologies. What such surveys often
fail to capture in full is students’ responses to the
question of whether technology does, in fact, enhance
learning.

Seminar: March 30th
Please join in a discussion of this topic:

March 30, 2004
12:00-1:30 P.M., 101 Walter Library
Moderators: Marvin Marshak and J. D. Walker

Marvin Marshak from the School of Physics and
Astronomy, Twin Cities campus and J. D. Walker
from the Digital Media Center will moderate a
discussion among several University of Minnesota,
Twin Cities students of questions such as:

• Does the combination of activity, technology
selection, and class organization provide students
with learning opportunities beyond what they
might experience in the traditional classroom?

• Do students perceive a difference between
“using technology” in a class and “learning with
technology?”

• What technology-enhanced instructional strate-
gies have students found particularly useful?

Campus projects
Linda Jorn, Melissa Martyr-Wagner, Laura Molgaard,
Tai Mendenhall, John Sonnack, Tina Stavredes, Ray
Voelker, and J. D. Walker.

Multi-College Student Survey: Experiences with
Instructional Technology Report. University of
Minnesota, November 2001. http://dmc.umn.edu
/surveys/student-eval/student-eval.pdf.

Bibliography and other resources
An overview of the topic, information about related
campus projects, a bibliography, and information
about related campus resources will be available on the
DMC web site a week before the seminar. A summary
of the seminar, a complete bibliography, and profiles of
the panelists’ projects will be available on that page
shortly thereafter. See: http://dmc.umn.edu
/spotlight/student-views.shtml

■ Chris Scruton and Christina Goodland,
Digital Media Center, http://dmc.umn.edu

Reminder:
Proposals Due

Feb. 17: TEL Grant Proposals
TEL Grant Program proposals
for 2004 are due by 4:30 P.M.,
February 17, 2004. See
http://dmc.umn.edu/grants/.

Feb. 20: DMC Faculty
Fellowship Proposals
DMC Faculty Fellowship Program
proposals for 2004–05 are due by
5:00 P.M., February 20, 2004. See
http://dmc.umn.edu/fellowship/.

April 27, 2004
Final Spring TEL Seminar

12:00–1:30 P.M.
101 Walter Library

Topic: Disciplinary TEL Teaching
Communities
The panelists will describe their technology-
enhanced learning (TEL) communities of
practice.

Participants

Moderator
Linda Jorn, Digital Media Center, Twin Cities

Panelists
• María Emilce López, Department of Spanish

and Portuguese Studies, Twin Cities
• Susan Henly, School of Nursing, Twin Cities
• William Riley, Health Services Research and

Policy, Twin Cities
• Micky Trent, Department of Clinical and

Population Sciences, Twin Cities
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Keeping Current with the Past
Current Awareness in key history databases

Nancy K. Herther, University Libraries, http://www.lib.umn.edu

Sam Cooke may have struck a cord
with his classic song: “Don’t Know
Much About History.” Since
history can be defined as everything
that has happened up until now,
there are few people on campus
who couldn’t benefit from the
lessons of the past.

Here on campus we have web access to two excellent
historical databases that, together, provide an excellent
resource for studying the history of just about every-
thing. Not only are they great databases to search on-
demand, but both also offer a current awareness
feature that allows you to get updates on your topic
(or updates for a specified listing of journals) sent
directly to your e-mail address each month.

Key historical databases: HA and AHL
Historical Abstracts (HA) and America: History and
Life (AHL) are actually two complementary databases.

• AHL covers the United States and Canada from
prehistoric times to the present day. Publications
have been indexed since 1964.

• HA covers the rest of the world from 1450 on-
wards, although you will find some references to
earlier times (with publications indexed since
1954).

Both databases include citations to articles published in
several languages, but all of the abstracts are in En-
glish. The databases will give you references and
abstracts of journal articles as well as some books and
theses.

This isn’t primarily a full-text database, although you
will find a few links to full-text articles. To find specific
articles, remember to check MNCAT™ for compre-
hensive access to all journals, books and other materi-
als held or accessible through the University Libraries.

Because of the nature of most research, you may want
to search in both databases for some historical topics
or geographic areas in order to do a comprehensive
search.

The web versions of both AHL and HA are updated
monthly; and the databases include new in-process
records (which may not yet have the abstracts written)
and with new completed-but-not-yet-published
records. The complete record will, then, be added as
the information is created.

❝ History is the version of past events
that people have decided to agree
upon.❞  Napoleon Bonaparte

America History and Life: AHL
AHL provides historical coverage of the United States
and Canada from prehistory to the present. The
database indexes and abstracts almost 400,000 entries,
adding approximately 16,000 entries each year. The
entries are compiled from over 2,000 journals, ap-
proximately 6,000 book and media reviews, and
dissertations.

In addition to covering all key English-language
historical journals, AHL includes selected historical
journals from major countries, state and local history
journals, and a targeted selection of journals in the
social sciences and humanities. Over 90% of the articles
included are published in English-language journals.

The database covers entries published from 1964 to
the present and includes 75-120 word abstracts for
journal articles. About 16,000 new entries are added
each year.
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Key search tips at-a-glance
■ Help: top left of screen

■ Truncation *(asterisk): for example,
immigrat* retrieves immigrate, immigrates,
immigration, etc.

■ Combine terms; use Boolean operators — and,
or, not — and parentheses ( ) where necessary.

■ Phrase searching: use quotation marks e.g.,
“weapons of mass destruction”

Historical Abstracts: HA
HA is an index to the history of the world — exclud-
ing North America — from 1450 to the present.
North American historical writings may be indexed if
they are relevant to the history of other regions. Every
year over 22,000 new entries from over 1,700 journal
titles published worldwide — including abstracts and
citations to journal articles, books, and dissertations —
are added to the database annually.

Historical Abstracts is multinational in scope, placing a
special emphasis upon the inclusion of English-lan-
guage journal and book titles published throughout
the world.

Since Historical Abstracts includes a targeted selection
of hundreds of journals in the social sciences and
humanities, this database is useful for research in
history, multicultural studies, sociology, psychology,
women’s studies/gender studies, religion, anthropol-
ogy, political science, history of science, economics,
business, education, music, art, and law.

Access to electronic journals
HA and AHL contain links to articles in many elec-
tronic journals, including:

Chronicon, Common-Place, Cromohs, Essays in
History, Journal for Multimedia History, Journal
of the Association for History and Computing,
Mennonite Life, Nordic Notes, North Star, Revista
Interamericana, and Screening the Past., H-Net
Reviews, and Media History Monographs.

❝ Those who cannot remember the
past are condemned to repeat it.❞
George Santayana

Value to researchers: an example
Regardless of your field, you are bound to find some
interesting perspectives and information of value in
these indexes. For example, a simple search on cloning
found many items, including this 1969 overview which
traces the history of cloning research in the early 20th
century:

Author: Russell, K.

Title: TISSUE CULTURE: A BRIEF
HISTORICAL REVIEW.

Citation: Clio Medica [Netherlands]
1969 4(2): 109-119.

Abstract: Surveys the subject of tissue culture
from Ross Granville Harrison’s first significant
studies in 1907 through research on cancer and
cloning during the 1960’s.

A search on the “death penalty” produced 133 items
in HA, which looked at the history of this form of
punishment throughout the world. A search on
“jihad” produced nearly 210 citations from the data-
bases. “University of Minnesota” produced 130 results
in AHL.

Searching
The databases offer sophisticated search techniques
that allow for general, single term searches or detailed,
specific searches. Here are some of the key options:

■ Keyword searches the entry’s abstract, title, subject
terms, documentation, and author fields.

■ Subject terms searches for index terms assigned by
the database editors. Geographical terms should be
inverted, e.g. minnesota minneapolis. Personal
names should be entered last name first name, e.g.
bush george.

■ Author/Editor searches for personal or institu-
tional author(s).
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■ Time Period searches for the historical time period
covered in the entry. Enter one or more round-
number dates. Follow each date by either “H” (for
centuries) or “D” (for decades). There are two
kinds of time periods:

Decades and hundreds-of-years:
• C 1920D=1920–1929 (decade)
• C 1900H =1900–1999 (hundred year period)

■ Document Type searches by specific type of article.
This function is very helpful when you are search-
ing for book reviews or want to limit your results
to only scholarly articles.

❝ We learn from history that we
do not learn from history.❞
Georg Friedrich Wilhelm Hegel

Browse
Each of these searching methods, plus the others
found on the basic search page, include a Browse
function. This function is helpful when you are
searching for very broad historical information
(e.g., Vietnam War or European Union). This is
especially useful when your original search strategy
fails to find the information you need.

To use the Browse function, click on the magnify-
ing glass icon which is located after each individual
search entry box.

Search
Simple Search is the default. This allows searching
for a keyword or phrase. You can combine this
with another term in a specified area, joined by
AND or OR as required.

The Advanced Search form allows searches to be
very specific, combining terms using AND or OR.

? and *
The wildcard symbol ? can be used for a single
unknown letter and * for an unknown number of
letters. For example, clon* will search for clone,
clones, cloning, etc.  Wom?n will search for woman
or women.

❝ History, despite its wrenching pain,
cannot be unlived, however, if faced
with courage, need not be lived
again.❞  Maya Angelou

CLIO Alert
CLIO Alert is an automatic e-mail feature that helps
you stay current in your areas of interest. Use it to
have new entries to the databases sent to your e-mail
account monthly. You can easily set up and manage up
to 10 profiles while in the databases.

Here is a step-by-step guide to setting up your alerts in
these databases.

1. From a search screen in either AHL or HA, click
on the underlined CLIO Alert Profile box. Enter
your user name (it should be a name that you can
easily remember). Click on the Create a Profile
button. Enter your first and last name in the “Your
name” field.

2. Enter the e-mail address to which the monthly
alerts should be sent in the “Your e-mail address”
field, a required field.

3. If you are setting up a new profile, you must
establish a password in the “Create profile pass-
word” field and verify it in the “Verify profile
password” field. (With a new profile, the “Create
profile password” field will be populated with a
default. Overwrite this with your own password
choice.)

Study the history of just about everything...
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In establishing and verifying your password, note
that certain special characters ($ * / ? \) and spaces
are not permitted.

Do not use your InternetID (X.500) and pass-
word or your e-mail or other accounts here on
campus!

If you are revisiting your profile, you may change
(and verify) your password if you desire, but it is
not required that you do so.

4. Select ASCII text or Tab-delimited as your pre-
ferred Output Format. (ASCII text is the default.)

5. Construct up to ten Alerts to be run against new
records each month.

You may choose to have each Alert run against
America: History and Life (AHL) and/or Histori-
cal Abstracts (HA).

You may also select the Join Operator between
fields to be either AND or OR (AND is the default
and is recommended for narrower searches). Note
that the default operator between terms within a
field is AND.

6. Click on a search field name (Subject Terms,
Author, Time Period, Language, Document Type)
for help on that field.

7. For assistance on constructing your Alerts, click on
a “content assistance” link.

8. To save your work and exit the Profile Editor,
select the “Save Profile” button. To return to the
search screen without saving any changes, select
the “Back” button located in the blue bar.

To delete your entire profile and exit, select the
“Delete Profile” button.

Your profile and all alerts can be modified at any time.
Automated searches are delivered in a single e-mail
message each month. You may then change any
information on your profile, including your password.
You can change or clear any alerts or add more, if you
do not have ten in your profile.

A profile will stay in place for one year after the last
time you accessed the profile. After ten months of no

Set up your alert in
four easy steps
The process is easy. Begin at the Libraries web
page: http://www.lib.umn.edu

1. Connect to either American History and
Life or to Historical Abstracts

2. Click on “CLIO Alert Profile” (on the
search screen).

3. Click on “Create a New Profile”

4. Follow the instructions to create up to
10 tailored alerts.

activity, you will receive an e-mail notice that you must
log in to your profile to keep it active. If you do not
do so, the profile will disappear.

❝ People that are really weird can get
into sensitive positions and have a
tremendous impact on history.❞
Dan Quayle

Questions? Need help?
If you have any questions about the database or
formulating your search, stop in any of the University
Libraries’ reference service desks, or use our
AskUs 24/7 reference service at
http://infopoint.lib.umn.edu/

■ Communications about this column should be
addressed to: Nancy K. Herther, Social Sciences
Bibliographer, 170b Wilson Library, West Bank;
612-624-2020; n-hert@umn.edu
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■ Add (subscribe info below at ✫)

■ Delete/Cancel *
■ Change Name *
■ Change Address *
■ Change Other *

* If you cancel or change a campus
address, please tell us the Record
No. Tear off the end page and send
the entire mailing label to us. Or send
e-mail to: oitnsltr@umn.edu

Twin Cities campus address label trivia: 1st # is record #; 2nd # is your Campus Mail delivery code, http://umn.edu/lookup

Newsletter subsciption information and archives at http://www.umn.edu/oit/newsletter

▼ Help
Computer Misuse or Abuse (also see Procedure 2.8.1.1)

• Emergency Network Help Line ............... 612-625-0006
• Non-emergency, e.g., spamming ....... abuse@umn.edu

1–HELP ....................................................... 612-301-4357
Dial 1-HELP. Listen to the voice menu list of options.
Press the number of your desired option.

• Technology Help .................. www.umn.edu/adcs/help

▼ Modem pool for active UM accounts
Internet/PPP: up to 53kps if v.90 ................ 612-627-4250

▼ Quick Guide
• Internet/Email account options .... www.umn.edu/validate

• Office of Information Technology ........... www.umn.edu/oit

• One Stop Services ................................ onestop.umn.edu

• Techmart ................................... www.techmart.umn.edu

• Computer Accommodation Program ............. cap.umn.edu

• University Computer Services ............. www.umn.edu/ucs

• MNCAT/LUMINA (Library) ...................... www.lib.umn.edu

• UM News Server ....................................... news.umn.edu

Associate Vice President and
Chief Information Officer, Steve Cawley ....... 612-625-8855

Last updated Dec. 2003

Subscribe/Unsubscribe

This newsletter is published monthly; it is an information
resource for the University of Minnesota. We maintain two
mailing lists. You can subscribe to one or both: an e-mail list
and a paper mailing list. Paper copies are free but are
mailed only within the USA.

Complete subscribe/unsubscribe details at:
www.umn.edu/oit/newsletter/subscription.html

● The subscriber information we need for paper copies
mailed to a UM campus mail address is listed below.

If you use a campus mail address, you will receive
your paper copy sooner and will save us money.

1. the recipient's name
2. the recipient's department
3. the departmental mailing address (note: this address

is usually different from your personal office address;
the Campus Mail section of your on-line directory
entry lists your campus mail address)

4. your campus delivery code — if you know it
(we can look it up; we need it because the
newsletter is a bulk mail item)

Subscribe/Unsubscribe


